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What is Fold-it ? 

Overview 
Fold-it is a software application that “de-imposes” flats i.e. divides them back into individual 
pages, and then outputs printed page proofs. The outcome is a proof of what your final 
document will look like after it has been run through the press, folded and trimmed. You end up 
with a proofing resolution copy of your printed booklet, magazine, newspaper, etc. The proof 
allows you to verify much more than just the page content. You can ensure that all pages are in 
the correct order and position, and it gives you the convenience and assurance of verifying a 
complete document in the same format in which one of your customers will be reading it. 

This proofing solution accepts imposition jobs that have been imposed with Preps or Apogee 
PrintDrive, as well as JDF files produced by any imposition application. All RIPped files of imposed 
flats must be in the 1-bit TIFF format. After a flat has been divided back into individual pages, 
each page is output as a composite, contone page at proofing resolution. The software makes use 
of the original imposition template of the imposition software to not only divide the pages, but 
also sort them and place them in the correct order. As a result, when you print the pages double-
sided, it will have the effect of recreating the final printed document after it comes off the press, 
folded and trimmed. Fold-it is a PC application which must be installed and run on a Windows 
machine. However it can process any of the types of jobs just mentioned, whether they were 
originally made with a Mac or PC imposition application. 

In order to accurately proof the final output, it is recommended that your printer be able to 
perform duplex (double-sided) printing and that this option is installed. Refer to your printer’s 
documentation if you need information on installing the duplex printing option. In addition, you 
can also generate corresponding PDF softproofing files. 

This updated Fold-it 3.0 Quick Reference Guide is based on Fold-it v3.0.6.9. 
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Fold-it terminology 
Since various imposition terms are used by prepress operators and imposition software, here is a 
list of the main terms used by Fold-it: 

• Imposition = 1 or more Signatures (i.e. an entire imposition job) 

• Signature = Book = 1 or more Press Sheets 

• Press Sheet = Web = 1 sheet of printed paper (front & back or front only) 

• Flat = 1 set of TIFFs (C, M, Y, K, spot) forming the front or back of a Press Sheet 
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Installing Fold-it 

Installation procedure 
Launch the Fold-it Installer on a Windows machine and follow the instructions provided. 

 

When prompted, choose a Job Storage Folder where all the job information (both temporary 
working files and permanent job files) that is processed by Fold-it will be stored. This setting can 
be changed after installation from the Job Storage Folder option in the Tools > Preferences menu. 
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Fold-it user interface 
When Fold-it is launched, the Fold-it user interface is displayed, as shown in the figure below. 

 

 

 

The Fold-it menus are shown below: 

 

 
 

 

 

Create a 
Preference Set 

Import an 
imposed job 

Print a job Spot colors list
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Configuring Fold-it 

The configuration of Fold-it is mainly done through its (i) Preferences, (ii) Preference Sets and (iii) 
Parsing Templates. In order to process a job with Fold-it, you have to configure the necessary items 
in the Fold-it general Preferences and at least one Preference Set. Parsing Templates are optional. They 
can be used to speed up the working time with Fold-it by allowing you to automatically assign 
1-bit TIFFs to flats. Preference Sets are necessary because they contain the parameters that 
determine how an imposition will be de-imposed (i.e. cut up into individual pages) and also the 
format in which the de-imposed proof will be output. 

Preferences 
General Fold-it preferences are set in the Preferences dialog box, accessed from the 
Tools > Preferences menu. 

General settings 
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Here you may set the Measurement units and the Processing priority for the Fold-it application. 

Save the processing log file should only be enabled for troubleshooting purposes at the 
recommendation of a Polkadots specialist, as it may create a large, unnecessary file over time. 

The Fold-it application includes a Spot color file, which is set by default in the Preferences. This 
database file contains a spot colors list which can be accessed through the Manage Colors dialog 
box (see  Managing Spot colors on p. 28 for more information). 

The Job Storage Folder stores all job information i.e. both temporary working files and permanent 
job files. 

Warning! 

Deleting the Job Storage Folder from the hard disk will result in the loss of all Fold-it job 
data. 

The Default Image Folder is where you specify the default TIFF folder where you keep all your 
1-bit TIFFs. This prevents you from having to browse each time you want to find your 1-bit 
TIFFs for a new job. If you do not have a single default TIFF folder, you may leave this 
preference blank. 

Import settings 

When a Preps job is imported, Fold-it also needs to import the Preps imposition template files. It 
will look for the Preps templates in two places: 

• in the Preps Template Folder, as specified in the Import settings (see screenshot below) 

• in the folder where your Preps job is located (as specified during the import) 
The same idea holds true for Printdrive jobs: when imported, Fold-it will need to access the 
Printdrive exported job folder and the Printdrive raster folder. The simplest setup is to specify these 
folders in the Import settings. 

When JDFs are imported, no additional files are required by Fold-it. 
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• if you use Preps, specify the folder where your Preps templates are located 

• if you use Apogee PrintDrive, specify both the Printdrive exported job folder and the Printdrive 
raster folder 

• if you will be importing JDF files into Fold-it, no import settings are necessary 

Preference Sets 
At least one Preference Set must be defined in Fold-it. This determines in part how your job will be 
de-imposed (i.e. cut up into individual pages) and also in what format the de-imposed proof will 
be output. Each time you print a Fold-it job, you will be prompted to choose a Preference Set. 

Preference Sets are created and edited in the Preference Sets Manager, accessed either from the 
View > Preference Sets menu or by clicking the Preference Sets toolbar button: 
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Preference Set options are divided into 5 categories: General, Calibration, Cutting Settings, Printer 
Output and PDF File Output. 
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General 

 

Here you set a Name and optional Description for the Preference Set. 
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Calibration 

 

The Calibration settings tell Fold-it how an imposition job was transformed (i.e. rotations, 
negative, offsets) during the printing process. Fold-it uses this information to transform a TIFF 
image of a flat back to its original state i.e. as it was oriented and positioned in the imposition 
software. 

If all jobs are printed similarly using the same PPD, which is often the case, one Press Sheet 
Calibration is sufficient. However, for jobs that are printed with different settings, you must either 
reset the calibration or create a different Preference Set for each type of calibration. 

Current values 

 

If you already know how an imposition job was transformed (i.e. rotated, mirrored, offset) during 
the printing process, you can specify this directly in the Current values. If you do not know this 
information, then you will have to visually calibrate the settings, as explained next. 
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Calibration settings 
To manually configure the TIFF & Press Sheet calibration, at least one job must be imported into 
Fold-it. If your Calibration settings are the same for all your jobs, then it can be configured after 
the first job has been imported and before it is printed. If the calibration settings vary with 
different jobs, then they have to be reset for each job or as necessary. 

In order to set the Calibration settings, select a job from the dropdown list and press the Calibrate 
button. The Press Sheet Calibration window will appear. 

 

 

Here you can calibrate the press sheet using the following tools: 

• browse the press sheet either by dragging the image in the main preview area (on the right 
side) with the hand icon or by clicking on a spot in the Area selector preview 

• specify whether the original imposition was printed as Negative, mirrored horizontally 
(Horizontal Mirroring) or rotated (choose a Rotation angle) 

Click in Area selector 
to display an area of 
the TIFF image 

Browse the imposed 
image by dragging directly 
on the image 
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• decide whether to Display Trim Box and Display Bleed Box 

• if your flat is printed with an offset, indicate it in the Press Sheet Position panel by moving 
the TIFF image with the arrow keys - use the folding marks, crop marks, trim box and  
bleed box to properly align the TIFF image to the imposition template 

 

 

Tip 

Click middle button in Press Sheet Position to reset to X=0 and Y=0 (no offset). 

Click middle button 
to reset to X=0 and 
Y=0 (i.e. no offset). 

Click arrow buttons 
to align the TIFF 
image of the plate. 
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Cutting Settings 

 

The Cutting Settings lets you set the following: 

• Resolution of Fold-it proofs 

• Default bleed margins (only for JDF jobs) 
 

Note 

Preps and PrintDrive jobs do not use the Fold-it bleed margins since they already 
have their own bleed margins defined. 
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Printer Output 

 

A Preference Set can be configured to output either a printed proof, a PDF softproofing file or 
both. Most of the configuration settings for a printed proof and a PDF proof are the same and 
are explained in this section. Any differences in the PDF proofing settings are explained in the 
PDF File Output section, starting on p. 24. 

If you wish to have a printed proof of your job, select a printer and configure how you wish the 
printed output to look. 

Printer properties 

 

The Properties button lets you configure settings that are specific to your printer model. The 
settings configured here only affect the way Fold-it jobs are printed when using this Preference 
Set. That is, they have no effect when printing to this printer from another application. 

Force Duplex 
This option is rarely necessary and should normally be left unchecked. It should only be used 
when a printer engine (e.g. Fiery) says that duplex-printing is not possible yet the printer that it is 
driving actually is capable of duplex-printing. In cases like this, Fold-it will force the printer 
engine to output the job as double-sided to the printer. 
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Preview 
The Preview shows a sample of what a page or spread will look like in reference to the paper size 
that it will be printed on, giving you an idea of whether the pages/bleed will fit or be cut off. 

The page size depends on what you select as the Sample Size. The total paper size depends on 
what is selected in the Printer Properties if you’re in Printer Output. Since there is no physical paper 
in PDF File Output, the total “paper size” is automatically calculated by Fold-it according to the 
selected Sample Size. 

Important 

For an accurate Fold-it proof, output a hard proof on a printer (using Printer Output 
settings) or a PDF softproof (using PDF File Output). The Preview should not be used 
as a proof. 

General printer settings 
 

D I S P L A Y  B L E E D  M A R G I N S  

Click the Display bleed margins checkbox to include the bleed margins around each page proof. 
Any objects extending outside the trim box will appear in the proof. 

 
I G N O R E  R E P E A T E D  P A G E S  

The Ignore repeated pages option can be selected for jobs that are imposed using ‘repeated page’ 
signatures. For e.g., some Preps templates have signatures where each page on the press sheet is 
repeated twice (referred to as 2-up) or each page is repeated three times (3-up). By default, when 
Fold-it proofs such jobs, it removes the repeated pages and only prints out one copy of each 
page. 

De-activating this option will preserve the entire imposition and print out all the pages, regardless 
how many times each page is repeated. If your jobs require you to verify the entire imposition, 
then deselect this option. 

By default, this option is checked, so that the proof is processed and printed more quickly. In 
addition, it also reduces paper waste by printing out smaller proofs. 

Page Layout settings 
 

L A Y O U T  

You have the choice of outputting proofs as a Single pages, Reader’s spread or Printer’s spread. 
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A U T O - R O T A T E  

This option is only available for single pages, not spreads. If you activate the Auto-rotate option, 
Fold-it will automatically set the orientation of the proof print-out based on the orientation of the 
page (i.e. portrait or landscape). 

 

C O N T E N T  P O S I T I O N  

This option is only available for single pages, not spreads. When printing the proof, you may 
indicate your preference for the position where the page will be printed on the paper. This setting 
will have no visible effect on the print-out unless the paper is sufficiently larger than the page 
size. 

Choose one of the nine tiles by clicking in a different position inside the Content Position box. For 
example, clicking on the top right area will position the page on the top right edge of the paper. 
The result is displayed in the Preview pane, as shown in the figures below. 

 

 

 

 

If the proof is output using duplex (double-sided) printing, the back page for each page pair will 
be printed directly behind the front page. 

 
S C A L I N G  

You can scale pages/spreads so that they fit within the selected paper size by choosing the option 
Fit inside printable area. 

Centered Top-left Bottom-right
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In addition, you can also scale pages (not spreads) so that multiple pages are proofed on a single 
piece of paper by selecting the option Multiple pages per side. You determine how many pages will 
fit on a paper by specifying Pages per side (horizontal and vertical).  

 

Marks and Extras 

 

 

D R A W  C O R N E R  M A R K S  

When no bleed margins are included in the proof, the corner marks are often sufficient for 
delineating the boundaries of a page. The corner marks correspond to the same page area as the 
trim box, except they only appear in the four corners rather than around the entire page. 

To change the length of the corner marks, click the Advanced button (refer to the section 
Advanced Marks Settings on p.23 for details). 

Reminder 

In order to see the layout marks (bleed margins, corner marks, etc.) when the proofs 
are printed, the paper size must be sufficiently larger than the page size. 
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D R A W  T R I M  B O X  

Choose this option to include the trim box around each page proof. Here, an actual line will be 
drawn around the page which shows exactly where a page will be trimmed after it rolls off the 
printing press. This helps distinguish the bleed area (outside the trim box) from the actual page 
(inside the trim box). The trim box is depicted as a thin grey line in the preview pane.  

 

D R A W  B L E E D  B O X  

Choose this option if you would like an actual line to be drawn on the proof delineating the bleed 
area around each page. Note that if you have not selected to Display bleed margins (see p. 17 for 
details), the bleed box will not appear on your proof. 

 

D R A W  F O L D I N G  L I N E  

This option draws a vertical line along the binding edge. It applies to spreads (Reader’s/Printer’s) 
only, not Single Pages. 

 
M A R K / B O X / L I N E  C O L O R  

 

It is possible to specify a different color for each mark, box or line by clicking the color bar 
(shown above). A window will appear, allowing you to specify an RGB color. 

 

Note that different mark/box/line colors can be only be specified for your printed proofs i.e. 
Printer Output – it is not available in the PDF File Output. 

 

D I S P L A Y  S L U G  L I N E  

You may include a slug line on a printed proof to help identify the page, by providing 
information such as which job it belongs to, the date and time it was produced and other relevant 
facts about the job. The slug line may be placed just about anywhere along the edges of the page. 
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To include a slug line: 

1. Click the Display slug line checkbox. 
2. Click the Configure button to the right of the checkbox. This will display the Slug Line 

Editor, shown below. 

n

p

 

L
E
G
E
N
D
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3. Type the desired slug line text (see Text and codes on p.21). 
4. Add codes if necessary (optional - see Text and codes on p.21). 
5. Position the slug line on the proof (see Odd Page Position on p.22). 

 

Begin by typing the text of the slug line in the text box. In addition to text, you 
may add codes that automatically print out facts about the job, as summarized 

in the Legend (see figure above). For example, typing %P in the slug line will print out the page 
umber on every page, whereas %B will print the book number. 

Consider the sample slug line shown in the first row of Table 1. If we were to proof a job called 
Auto Magazine on July 18, 2004, this sample slug line (text and code) would print on each page 
roof as shown in the table below. 

Text and codes 
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Sample slug line 
(text and code) 

Sample Fold-it job called %9N, Page %P, output on %D 

Page 1 Sample Fold-it job called Auto Maga, Page 1, output on July 18, 2004 

Page 2 Sample Fold-it job called Auto Maga, Page 2, output on July 18, 2004 

Page 3 Sample Fold-it job called Auto Maga, Page 3, output on July 18, 2004 

Table 1 –  Slug line example 

As indicated in the legend of the Slug Line Editor, a job name is specified with the code %#N, 
where # represents the maximum number of characters allowed for the job name. This is why in 
the example, the slug line truncates the job name Auto Magazine down to 9 characters (%9N), 
resulting in Auto Maga. However, note that this only affects the slug line - the actual job name itself 
will remain unchanged. 

The Odd Page Position specifies where on an odd page you would like to 
position the slug line. Fold-it uses this information to automatically mirror the 

position of the slug line on all even pages. 

The Corner dropdown list lets you choose the corner of the page where you would like to place 
the slug line. If your document will be bound on the left side, as is usually the case, the binding edge 
for an odd page is on the left and the thumb edge is on the right. Should your document be bound 
on the right side, the binding and thumb edges are reversed. Therefore, for an odd page on a 
typical left-bound document, choosing Bottom binding edge will place the slug line on the bottom 
left corner. 

The Orientation determines the direction of the slug line. 

The Trim area determines whether the line will be printed inside the trim area (effectively on the 
image itself) or outside the trim area. 

The Text facing option lets you choose whether the slug line faces The edge of the page, meaning 
away from the center of the paper, or The inside of the page, meaning towards the center of the 
paper. For example, a slug line placed at the bottom of a page and facing towards the edge of the 
page would appear right side up, whereas the same slug line facing towards the inside of the page 
would be placed at the same location but would appear up side down. 

The Extra offset allows you to precisely position a slug line virtually anywhere on the proof. The 
amount of the offset is applied after all the other odd page position settings have been applied. 
To specify the offset, type a number for the X offset (horizontal) and the Y offset (vertical). The 
numbers typed represent the unit of measurement (inches, millimeter, etc.) that is specified in the 
General Settings of the Fold-it Preferences. Negative numbers can also be used. 

Odd Page Position 
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Furthermore, you may also choose the font size of the slug line by making a selection in the Point 
size dropdown list. 

Please note that when a slug line is added, it is not shown in the Preview pane. 

 
P R I N T  A  C O V E R  P A G E  

There is the possibility of adding a cover page in order to keep your printed proofs more 
organized. A cover page will help to clearly identify each job and to easily distinguish one job 
from another. To include a cover page, put a check in the Print cover page checkbox and specify 
When to print it and what Paper tray to use. 

A cover page can be included at the beginning of every job or the beginning of every signature, 
as specified in the When dropdown list. You can also choose which paper tray will supply the 
paper for the cover page. 

You are given the option of selecting a different paper tray to print the cover page than what is 
used to print the proof. This permits you to output your cover page in a different format from 
the proofs so that you can more easily distinguish the beginning of each new job or signature. 
Regardless, the cover page will still be output together with the proofs and in the correct order. 

To change the position of the text on the cover page, click the Advanced button (refer to the 
section Advanced Marks Settings for details). 

 
A D V A N C E D  M A R K S  S E T T I N G S  

Clicking the Advanced button opens the Advanced Marks Settings dialog box, giving you access to 
the following options: 

 

Corner marks length: specify the desired length of the corner marks. 

Cover page content vertical position: select where the content (text, etc.) will be positioned on the 
cover page. Select Top, Bottom or Auto to let the software decide where to put the text. 
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PDF File Output 

 

A Preference Set can be configured to output either a printed proof, a PDF proofing file or both. 
Most of the configuration settings for a PDF proof are the same as for a printed proof and are 
explained in the section Printer Output, starting on p. 16. This section explains only the options 
and properties unique to the PDF File Output. Note that a few options that pertain specifically to 
printers, such as Print Cover Page, are not available for PDF softproofs. 

If you wish to have a PDF softproof of your job, check the option Enable PDF file output and 
configure how you wish the PDF output to look. 

PDF properties 

 

Clicking the Properties button displays the PDF Document Properties dialog box. 
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When generating PDF proofs, you need to set the Output Folder where Fold-it will store the PDF 
files. You can also choose to divide a proofing job into several PDF files instead of a single PDF. 
Using the option Create multiple documents divided by, you can specify that one PDF file be 
generated for each Page/Group or for each Signature. 

You can also specify the compression type (e.g. JPEG, LZW, RLE) and level for your images. 

Parsing Templates 
The Parsing Templates dialog box can be accessed from the Tools menu. 
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Here you can create and edit Parsing Templates, which are used by Fold-it to automatically 
determine which TIFF files correspond to which flats in an imposition template. TIFF files 
produced by a RIP are often named according to a particular naming convention which includes 
information about the file, such as color, signature number, job name, etc. By specifying the 
naming convention of your TIFF files in a Parsing Template, Fold-it can extract this information 
from the file name and use it to automatically associate and assign the TIFFs to a particular flat 
on the imposition template. More on the Auto assign feature can be found on p. 35. 

Note that Parsing Templates are not required for PrintDrive jobs. Also note that for other types 
of jobs (i.e. Preps, JDF), Parsing Templates are not absolutely mandatory either. However if 
none are configured for Preps or JDF jobs, TIFF files will have to be manually assigned to flats 
in the imposition template for each new job. 

Clicking the New button opens the File Name Parsing Template Editor, shown below. 

 

Creating a Parsing Template 

To help create a Parsing Template, you can add a Sample Name by typing it or browsing for a 
TIFF file from an existing job. This way as you build your template, you will immediately see 
how Fold-it will parse this type of filename in the Sample Results window. 
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You create the template by inserting one or more Predefined Fields (selected from the Insert Field 
Name dropdown list) along with the Length Condition for each field. An example is shown in the 
following figure. 

 

In the example above, the filename parsing template <FLAT|->?<NAME:5>?<COLOR|.> was created 
by inserting 3 fields: 

• 1st field: Insert Field Name = FLAT and Length Condition = “Extract up to this character  – ” 

• 2nd field: Insert Field Name = NAME and Length Condition = “Extract this many characters 5 ” 

• 3rd field: Insert Field Name = COLOR and Length Condition = “Extract up to this character . ” 
 

In addition, the template includes the ? character in two places. This character was typed in 
manually and instructs Fold-it to skip a single character as it parses a filename. Fold-it may be 
instructed to skip single or multiple characters in a filename if they do not contain any useful 
information. To skip a string (i.e. a consecutive group of characters), insert the SKIP field and 
specify the Length Condition. 

Every time the template <FLAT|->?<NAME:5>?<COLOR|.> parses a TIFF filename, it will:  
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• extract all characters in a TIFF filename until it reaches a dash “-” and store these 
extracted characters in a field called FLAT (this identifies the Flat number to which this 
TIFF belongs) → in the example above (2-54321_PANTONE_146 C.pdf), FLAT = 2 

• skip one character → in the example above (2-54321_PANTONE_146 C.pdf), skips the dash 
“-” 

• extract the next 5 characters in the file name and store these in the Job NAME field → in 
the example above (2-54321_PANTONE_146 C.pdf), NAME = 54321 

• skip one character → in the example above (2-54321_PANTONE_146 C.pdf), skips the 
underscore “_” 

• extract all characters up to the period “.” as the COLOR name → in the example above 
(2-54321_PANTONE_146 C.pdf), COLOR = PANTONE_146 C  

Note how in the figure above the Sample Results window automatically shows the parsing results 
of the template because a Sample Name was specified. This is a simple, yet effective way to 
immediately verify if the template has been properly constructed and you are getting the results 
you expect. 

Managing Spot colors 
By default, Fold-it includes a spot color list, as specified in the Preferences (see p.7). This list 
contains common spot colors and their equivalent CMYK values, which Fold-it uses to proof 
spot colors contained in jobs. 

Spot colors are managed through the Manage Colors dialog box, which can be accessed from the 
menus by clicking Tools > Manage Colors or through the Colors icon on the toolbar: 

 

 

Note 

If you workflow includes the PrePage-it application, note that the Spot Colors List 
for Fold-it is not the same as for PrePage-it – they are two distinct spot color lists. 
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Spot Colors 

 

The Spot Colors tab lets you mange spot color definitions. You can: 

• verify existing spot color definitions by selecting any listed color 

• modify existing definitions by selecting a color, changing the CMYK values and clicking 
the Save button 

• add a new spot color definition by typing a new spot color name, specifying the CMYK 
values and clicking the Save button 

• delete a spot color via the Delete button 
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Aliases 

 

The Aliases tab provides an alternative way of managing spot colors by allowing you to define 
aliases for existing spot color definitions. For example, let’s say a job contains a spot color called 
Pantone 100 CV. You verify the spot color list and notice that it does not include this pantone, but 
includes an equivalent color such as Pantone 100 CVC, whose spot color definition is identical. 
Rather than adding a new spot color definition for Pantone 100 CV, you can create an alias which 
tells Fold-it that Pantone 100 CV = Pantone 100 CVC (see screenshot above). 

Aliases can be created for any new spot color whose CMYK value is the same as an existing spot 
color i.e. one that is already in the spot colors list. 

To create an alias: 

1. Type the new spot color name in the Alias text box. 
2. Select an equivalent color in the Color text box. 
3. Click the Save button. 

Note that whether you add a new spot color definition or create an alias, Fold-it will yield the 
same result when processing a job, as long as the same CMYK definition is being used. 
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Using Fold-it 

Using Fold-it to proof an imposed set of 1-bit TIFF files is basically a three-step process: 

1. Import the job into the Fold-it application through the use of the Imposition Import 
Wizard. 

2. Locate the 1-bit TIFF plate files and assign them to their corresponding flats. 
3. Print the proofing job. 

This 3-step procedure is described in the next few sections. Note that depending on the type of 
job you process, the procedure may vary slightly. For example, if you import a PrintDrive job, it 
is not necessary to assign TIFFs to flats as described in step 2. 

Importing jobs 
Jobs are imported into Fold-it with the Imposition Import Wizard, which can be accessed from the 
menus (File > Open Imposition) or the Open toolbar button: 

 

Fold-it can import three types of imposed jobs: JDF, Preps and Apogee PrintDrive. 
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Depending on the choice you make, Fold-it will guide you through the steps required to import 
the job. Once the import has been completed, you should see the “Imposition import 
successful” message. The job will then appear in the main Fold-it window. 
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• For Preps jobs, you will be prompted for the Preps .job file. 

• For Apogee PrintDrive jobs, you will be prompted either for the PrintDrive .pdj file or the 
PrintDrive ID number. 

• For JDF jobs, you will be prompted for the .jdf file. 
 

Important 

If you have not specified the Preps Template Folder in the Preferences > Import settings, 
then the Preps template files must be located in the same folder as the Preps job that 
you import. The same idea holds true for Printdrive jobs. Refer to the section Import 
settings on p.8 for more details. When JDFs are imported, no additional files are 
required by Fold-it. 

Assigning TIFFs to flats 
After a job has been imported, Fold-it can understand how the job was imposed. The next step is 
to locate all the 1-bit TIFF imposition files and then match each one of them with the 
corresponding flat in the imposition template. 

Note 

Assigning TIFFs to flats is not necessary for PrintDrive jobs, only for Preps and JDF. 

Overview 

To assign TIFFs to flats, right-click on a job in the main window and choose Modify from the 
contextual menu. The Modify command can also be accessed from the Imposition menu when a 
job is selected. The following dialog box will be displayed. 
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The Modify dialog box shown above displays the imposition template on the left side and the 
1-bit TIFF imposed files on the right side. It is in this window that you must specify which TIFF 
images correspond to which flats in the template. The imposition template shown on the left 
should be the one that you used to impose the job in your imposition application. If not, you 
should redo the job import process (refer to Importing jobs on p.31 for details). 

Assigning TIFFs can either be done automatically using the Auto assign feature or it can be done 
manually. TIFFs can be assigned as soon as you inform Fold-it about their location on the hard 
disk. All this is explained in the next few sections. 

Locate the TIFFs 

Before assigning TIFF plates files to their corresponding flats, you must choose the folder where 
the TIFFs are located (Browse an image folder). This will display the TIFF files in the Modify dialog 
box shown in the figure above. 

• Check Include subfolders if the TIFF files are located in different subfolders. 
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• Check Filter out non-TIFF files to display only the TIFF files contained in that folder – 
non-TIFF files will be hidden from the list. 

• Use the Search tool to quickly locate a particular file or set of files beginning with the same 
characters. Begin typing the first few characters of a filename(s) and all other TIFF files 
(not beginning with the characters you typed) will be hidden from the list. The figures 
below show how typing “2-” filters out all but the two files beginning with those 
characters. 

 

 

 

 

 

 

Auto assign 

If Parsing Templates (see p.25) have been properly configured beforehand, TIFF files can be 
quickly assigned to their corresponding flats. To do so, simply select an appropriate Parsing 
Template from the dropdown list, then click the Auto assign button. All the TIFF files listed on the 
right side of the window will go to the left side, into their corresponding flat. 

All files contained 
within a folder are 
listed 

Only the files 
beginning with 2- 
are listed 

Search tool

Searching for filenames starting with 2-
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If you need to remove the TIFFs from the left side of the window and re-assign them to other 
flats, click Reset. The TIFFs will go from the left side of the window back to the right side, where 
they can be re-assigned. 

In this example, 4 TIFF files 
were auto-assigned to 2 flats. 
Side A and Side B of Signature 
1 were each assigned 2 TIFFs.

1) Select a Parsing Template. 2) Click “Auto Assign”. 

Signature 1: Side A (Front) and Side B (Back) 
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Note 

For the Auto Assign to work properly, the 1-bit TIFFs have to be named in a way that 
corresponds to the selected Parsing Template. For example, the Parsing Template 
<NAME|_>_<COLOR|_>_<IFLAT|.> will correctly parse filenames which consist of a job 
name followed by an underscore, then followed by the color separation and another 
underscore, and finally the flat number. If your TIFF filenames do not correspond to 
your Parsing Template, consider modifying the template. 

Manual assign 

To manually assign TIFFs to a flat, open the Modify window (see previous screenshot) and do 
one of the following: 

1. Drag (move) the TIFF files from the right side of the Modify window to the desired flat 
on the left side. 

-or- 

1. Select a flat. 
2. Select one or more TIFFs using Shift+click (for continuous files) or Ctrl+click (for non- 

continuous files). 
3. Click the Assign button. 

As is the case when Auto assigning TIFFs to flats, if you need to remove the TIFFs from the left 
side of the window and re-assign them to other flats, click Reset. The TIFFs will go from the left 
side of the window back to the right side, where they can be re-assigned. 

Managing color separations 

After a job has been imported and TIFFs have been assigned to flats, Fold-it extracts the names 
of the color separations for each flat. This process may sometimes produce results which will 
require your attention, namely: 

• some colors in a flat may be identified incorrectly, or 

• some spot colors in a job may not correspond to anything in Fold-it’s spot colors list 
 

Changing a color separation 
If a color separation has been incorrectly identified or for any other reason you wish to change 
the color name, you can do so in the Modify dialog box (shown in the next 2 figures). To change 
the color name for a separation (i.e. TIFF plate file), click on the color name to highlight it, which 
at the same time displays the color dropdown list. 
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Then either choose a different color from the dropdown list or type another color name. 

 

 

Adding a spot color 
Fold-it needs to have a spot color definition for all spot colors present in a job since it refers to 
these CMYK equivalent values to output its proofs. If a spot color name in a job does not 
correspond to anything in its spot colors list, Fold-it cannot proof the job with the correct colors. 
When this occurs, you may get a message such as the following: 

 

In order to output the Fold-it job, you will need to click Yes and add the color definition to 
Fold-it’s spot colors list. If you wish to do this later, you may click No and then add the color 
definition using the Manage Colors dialog box at a later time. Please refer to Managing Spot colors 
on p.28 to know how to add spot color definitions. 
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Printing jobs 
How to print 

When you are ready to print a job, open the Print dialog box in one of the following ways: 

• select a job in the main window and click the Print icon  from the toolbar 

• right-click on the job and choose Print from the contextual menu 

• double-click on the job 
The Print dialog box allows you to print the entire job or only certain specific Signatures or Pages. 
When printing selected Signatures, you can choose whether to print the Front, Back or both. 

To specify signature or page ranges to print, use the dash “-” to indicate a continuous range and a 
comma “,” to separate multiple ranges. For example, 1-4,8,10 will print 1, 2, 3, 4, 8, 10. 

 

A Fold-it job is printed according to the Preference Set selected. Preference Sets specify a host of 
parameters regarding how a job will be de-imposed and printed (see p. 9 for more information). 

By clicking the Customize button, it is also possible to customize some settings from the selected 
Preference Set. The customization made in the Print dialog box will apply only to that print job 
and will not affect the actual Preference Set. If you’ve customized some Preference Set settings in the 
Print dialog box and you wish to return to the default Preference Set, just re-select the Preference 
Set in the Preference Set dropdown list. 

In most cases, Discard intermediate files should not be activated since it will slow down the 
processing and printing of jobs. Activating this option will force Fold-it to re-calculate and 
regenerate a job from scratch if it is reprinted. This may be used if a major change has been made 
to a job and it needs to be re-output or for problem jobs. 

After selecting the desired print options, click the Print button. 
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Monitoring printing progress 

While a job is being printed, the Processing Imposition dialog box will display the progress of the 
job. If any errors occur in the job, they will also be shown here. 

 

You may cancel the print job at any time by clicking the Cancel or Close button. 

The following figures show a sample Fold-it print job containing 2 colors (Black and Pantone 146 C) 
and 16 pages (8 on the front, 8 on the back). 
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Depending on the Preference Set used, the Fold-it print job will output print-outs on your 
selected printer and/or PDF files in the specified Output Folder. Each job will also generate a set of 
files in the Job Storage Folder (see General settings on p. 7), but these are for Fold-it’s internal use 
only. 

Deleting jobs 
To delete a job, right-click on the job and choose Delete from the contextual menu (Delete can 
also be accessed from the Imposition menu). The Delete dialog box allows you to delete (i) the 
entire Fold-it job i.e. all files generated by Fold-it, (ii) only the original job file or (iii) only the 
original TIFF image files. Choosing the option Delete from the Fold-it database will keep your 
original job and TIFF files. To remove all files related to a job, check all three checkboxes. 
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